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Introduction 

About this user guide 

This user guide is for users of the Gateway version of the Electronic Receipting computer system 
(ERS). There are two versions available: 

 this version for Gateway programmes; and 

 a separate version for Training Opportunities and Youth Training programmes. 

Both are downloadable from TEC website or from the ERS online help (see Help for instructions on 
accessing it).  

Getting help 

Use the following table to decide where to get help: 

STEP COMMENTS 

1. Check the user 
guide 

The information you need is probably available in this user guide. 

2. If you still need help If you cannot find what you need in the user guide, then contact one of the 
following: 

IF THE PROBLEM RELATES TO … THEN … 

Queries around enrolment 
issues and funding rules 

Refer to the Gateway Handbook for Schools 
available from the TEC website or 
 
Contact the TEC Service Centre on 0800 601 
301 or servicecentre@tec.govt.nz 
 

Technical problems using  
ERS 

Contact the TEC Service Centre on 0800 601 
301 or servicecentre@tec.govt.nz 

Technical problems with 
ESAA login or the National 
Student Index 

Contact the Ministry of Education Sector Service 
Desk at 0800 422 599 or 
sector.servicedesk@minedu.govt.nz 
 

  

http://www.tec.govt.nz/Resource-Centre/Software-tools/ERS/
http://www.tec.govt.nz/Resource-Centre/?search=True&fund=95&resource=136
http://www.tec.govt.nz/
mailto:servicecentre@tec.govt.nz
mailto:servicecentre@tec.govt.nz
mailto:sector.servicedesk@minedu.govt.nz


Getting started  

Obtaining username and password 

You cannot access ERS until you have been set up in ESAA1. Using your ESAA user id and 
password also gets you into ERS. 

Contact the Ministry of Education Sector Service Desk (0800 422 599 or send an email to 
sector.servicedesk@minedu.govt.nz) if you need help getting set up in ESAA. 

Logging in 

You can log into ERS once you have an ESAA username and password. The Login screen 
describes how to do this. 

Notes: 

 You will be automatically logged off if ERS has been inactive for 30 minutes. 

 Access to ERS is subject to the privacy conditions described in the Gateway Handbook for 
Schools (available on the TEC website here). Each school using ERS is responsible for 
advising the Ministry of Education Sector Service Desk sector.servicedesk@minedu.govt.nz  
when a staff member leaves their employment, or moves from the ERS role.  

Using ERS 

You can start using ERS once you are logged in. The screens are described under the following 
groupings: 

TYPE OF SCREEN PURPOSE 

Programme screens There are two screens dealing with programmes: 
 

 The Programmes List screen lists all the programmes the school is 
authorised to provide. 

 
 The Programme Details screen lists the students enrolled in a particular 

programme. 
 
These are the main screens you will use and you will keep returning to them. 
 

Enrolment screens You will use this series of screens when enrolling a student on a programme. They 
are accessed via a programme screen. 
 

Other action screens These are all the other action screens (eg. amend student details). They are also 
accessed via a programme screen. 
 

Security screens This group of screens help protect ERS from unauthorised use.  

An overview chart is available showing how the screens all fit together. 

Logging out 

Remember to log out when you have finished. 

                                                 
1 ESAA stands for “Education sector authentication and authorisation”.  It is a web-based service that controls access to 

many education sector computer systems. 
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General techniques 

Mandatory fields 

Mandatory fields are marked with a red asterisk.  For example, in the screen below both National 
Student Number and Date of birth are mandatory. 

 

Use the ERS buttons 

It is very important to use ERS’s buttons. For example: 

 

…not the browser Back 
button… 

…and not the X button. 

BE WARNED: Using the browser to navigate or close screens will lose all your data entry in some 
situations. 
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Menus 

Menu items are listed across the top of most of the screens like this: 

 

 

This describes those menu items: 

MENU ITEM COMMENTS 

Home 
 

Clicking the Home menu returns you to the Programmes List screen. 

User services 
 

Click the User Services menu to change any of the following: 

 Your password. 

 Your challenge response questions. 

 Your ESAA profile (see note below). 

 Change organisation (only appears if you have authorisation to act on behalf of more 
than one organisation). 

 
NOTE: “ESAA stands for Education sector authentication and authorisation”. It is a 
web-based service that controls access to many education sector systems. You cannot 
access ERS until you have been set up in ESAA. 
 

Help 
 

Clicking the Help menu displays a page from which you can download this user guide. 
 
Make sure you choose the ERS Help menu like this: 
 

 
  

Log out 
 

Clicking the Log out menu logs you out of ERS.  See Logout screen for more detail. 
 
IMPORTANT:  Always log out when you have finished to avoid unauthorised access to 
ERS. 
 

Click ERS help… 

…not the browser help 

These are the 
menus. 
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Screens:  Overview chart  

This shows how the various screens link together: 

Login to ERS

Amend Student 
Details

Enrol Students

Programme Details

Programmes List

Choose 
Organisation

 (If you have access 
to other Schools)

Withdraw Student

Park Enrolment

Record Outcomes
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Screens:  Programmes 

This section describes the two screens that list programmes and their details. They are the main 
screens you will use. 

Programmes List screen   

Use the Programmes List screen to display: 

 All the programmes the school is authorised to provide. 

 All “parked” enrolments. (You can park an enrolment partway through data entry if you 
need to clarify data or obtain missing data before continuing. Everything you have entered 
so far will be saved). 

The Programmes List screen first appears on logging in (see Login screen). In many situations, 
you will return to it after using making changes via the Action screens.  Either:  

 Search: Enter the Programme number or programme name or part of the name 

 Filter the list: Limit the display by selecting filters from the drop down lists 

 

 

Most schools have only one programme.  However, if you have 
more than one, you can use this area to SEARCH for a 
programme, or to FILTER the display to restrict the list to 
programmes meeting certain criteria. 

Always check that you have 
the correct school. 

This area lists all programmes the school is approved 
for.  You can make it shorter by searching or filtering. 

NOTE:  You can display a programme’s 
details by clicking its number. 

This area lists any 
parked enrolments. 

 

Clicking on the programme number (on the left) displays the Programme Details screen where you 
can: 

 View detailed information about a programme (start and end dates, number enrolled and 
maximum permitted and list of students). 

 Enrol a new student in a programme. 

 Resume data entry for a parked enrolment. 
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FIELD, BUTTON, LINK COMMENTS 

SEARCH AREA 

Number Programme number. 

Name Part or all of the programme name. 

Search button Click this to execute the search.  The programmes list changes to reflect the search 
criteria. 
 
NOTE: ERS will take you directly to the Programme Details screen if there is only one 
programme in the search result. 
 

Reset button Click this to clear the search fields. 

FILTER AREA 

Area Eg. Northland.   

Fund Gateway. 

Status Active / Pending / Complete. 

Filter button Click this to execute the filter. The programmes list changes to reflect the filter criteria. 

Reset button Click this to clear the filter fields. 

PROGRAMMES LIST 

Number 
Name 
 

List of all programmes you are approved for. You can make it shorter by searching or 
filtering. 

Number link The programme number is also a link. Click it to see detailed information about the 
programme.  The Programme Details screen appears. 
 

Enrol link Click this to enrol a new student in the programme. The Student Details screen will 
appear.  
 
NOTE: Remember to take parked enrolments into account when deciding whether to 
accept additional enrolments. 
 

PARKED ENROLMENTS 

NSN 
First name 
 

List of all parked enrolments. 

Select link Click this to restart enrolment of the new student. The Student Details screen will 
appear. 
  

Delete link Click this to delete a parked enrolment started in error. You will be asked to confirm the 
deletion. If you delete the enrolment all of its data will be lost. 
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Programme Details screen 

Use the Programme Details screen to display detailed information about a particular programme 
including: 

 Fund, start and end dates, and programme status. 

 Number of students currently enrolled in the programme and the maximum permitted. 

 List of students. 

Starting at the Programme Details screen, you can: 

 Enrol a new student. 

 Amend a student’s details. 

 Delete a student when it is the same day as the student was enrolled. 

 Withdraw a student from the programme. 

 Record the outcome for a student. 

The Programme Details screen appears after clicking the programme number in the Programmes 
List screen. 

 

Always check that you have 
the correct programme. 

…or click one of these links to 
amend student details, withdraw or 
delete them or record an outcome.

Click this link to enrol 
a new student. 
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FIELD, BUTTON, LINK COMMENTS 

SUMMARY DETAILS (AT TOP) 

Fund 
Programme start date 
Programme end date 

High-level details about the programme. 

STUDENTS  

Number of students 
currently enrolled 

Number of students currently enrolled in the programme and maximum permitted. 

Enrol link Click this to enrol a new student in the programme. The Student Details screen will 
appear. 
 
NOTE: Remember to take parked enrolments into account when deciding whether 
to accept additional enrolments. 
 

LIST OF STUDENTS 

NSN 
First name 
Last name 

List of all students enrolled in this programme. 

Amend link Click this to amend student details. The Amend Student Details screen will appear. 

Delete Placement link Click this to delete a student enrolled in error. The Delete Placement screen will 
appear. 
 
Notes: 

 The option of “deleting” a student is available only if the programme has not 
yet started OR the student was enrolled today. (Otherwise you are given the 
option of “withdrawing”). 

 After deleting a student from a programme the student will no longer show 
as an active enrolment. 

 

Withdraw link Click this if the student is withdrawing from a programme before the programme-
end date. The Withdrawal screen appears. 
 
IMPORTANT: Complete a “Placement in error” form if you are withdrawing a 
student as the result of a placement error. The TEC will use the information you 
provide to help identify any payment adjustments that may be needed. (The form is 
available on the TEC website here).   
 
NOTE: The option of “withdrawing” a student is available only if the programme has 
started AND the student was enrolled before today. Otherwise you are given the
option of “deleting”. 
 

Record Outcome link Click this to add an outcome for the student. The Record Outcome screen will 
appear.  
 
Notes: 

 This cannot be done until three months after withdrawal. 

 Only TEC will be able to change the outcome after it has been submitted. 
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Screens:  Enrolment 

This section describes the enrolment screens. These are the series of screens that appear when 
you enrol a student in the Gateway programme. 

NOTE:  The screens are described in their order of appearance. 

 

-Student Details screen 

Use the Student Details screen to: 

 download student details from the National Student database; and 

 enter student contact details. 

Display it by: 

 clicking an Enrol or Select link in the Programmes List screen; or 

 clicking the Enrol link in the Programme Details screen. 

 

 

 
FIELD, BUTTON, LINK COMMENTS 

National Student Number You cannot enrol a student without the NSN. 

Date of birth 
Name 
Gender 

Fields will automatically populate when you click the Lookup NSN button if the 
information is available in the National Student Index. 

3. The remaining fields update automatically (if 
the information is available in NSN).  Modify 
anything that has changed. 

4. Click the Next button. 

1. Enter the National Student 
Number and date of birth. 

2. Click the Lookup NSN 
button. 
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FIELD, BUTTON, LINK COMMENTS 

Lookup NSN button Click this after entering the NSN and date of birth. The remaining fields will 
automatically fill if the information is available in the National Student Index. 
 
 

Clear NSN button Click this to clear the NSN and start again. 

Street 
Suburb 
Town / City 
Contact phone number 
Other phone number 

Information will automatically populate when you click the Lookup NSN button if 
the student has previously been enrolled on a TEC funded programme. 
Amend as appropriate. 

Next button Click this to move to the next screen. 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information.  The Parking screen will appear. 
 
NOTE: Parking an enrolment saves data from all four of the enrolment screens 
not just the one you are looking at. 
 

Cancel button Click this to cancel the enrolment.  All information entered will be lost.   
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Statistical Information screen 

Use the Statistical Information screen to enter statistical information such as ethnic group, 
employment history and so on. The screen appears after clicking the Next button in the Student 
Details screen: 

 

 
FIELD, BUTTON, LINK COMMENTS 

Year at school Select the student’s school year. 

Ethnic group Select one or more by holding down the Ctrl key. 

Main tribal group Select from the drop-down list (only if your selections included New Zealand Māori). 

Other tribal affiliations Select any other tribal affiliations. To select multiples: 
 

 select the first one; 

 press the Ctrl key and keep holding it down while you click your second 
selection; 

 keep doing this until you have selected all the required affiliations. 
 
WARNING: You will have to start again if you forget to hold the Ctrl key down. 
 

Back button Click this to return to the previous screen. (You will not lose what you have entered.)

Next button Click this to move to the next screen. 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information.  The Parking screen will appear. 
 
NOTE: Parking an enrolment saves data from all four of the enrolment screens not 
just the one you are looking at. 
 

Cancel button Click this to cancel the enrolment. All information entered will be lost.   

4. Then click the 
Next button. 

3. …plus any other tribal affiliations. 

2. If your selections include New Zealand Māori 
you must also specify a main tribal group… 

2. Select one or more 
ethnic groups.

1. Select the student’s 
school year.
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Placement Details screen 

Use the Placement Details screen to enter information about the placement. The screen appears 
after clicking the Next button in the Statistical Information screen: 

 

 
FIELD, BUTTON, LINK COMMENTS 

Employer Select the employer. 

Industry Select the industry the employer fits within. 

To add, edit, delete … Sometimes you will need to: 

 add a new employer to the list; or 

 edit employer details; or 

 delete an employer. 
 
To do this, click the red link on the right of the screen: 

 
 
The Maintain Employers screen will appear. 

Employer contact 
Contact phone 
Address 

This information is automatically filled when you select the employer / industry if 
previously entered. (See page 22) Amend as appropriate. 

Student start date Date the student started the employment. 

Proposed duration Proposed duration of the employment (in weeks). 

Proposed hours per week Proposed hours per week during the employment. 

Click the red link.

4. Then click the 
Next button. 

3. Complete these 
details. 

2. On selecting the employer, their details 
appear here.  Make any corrections as 
necessary. 

1. Select the employer and their industry.  
(NOTE: Also see “To add, edit, delete…” in 
the table below). 
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FIELD, BUTTON, LINK COMMENTS 

Back button Click this to return to the previous screen. (You will not lose what you have 
entered.) 

Next button Click this to move to the next screen. 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information.  The Parking screen will appear. 
 
NOTE:  Parking an enrolment saves data from all four of the enrolment screens 
not just the one you are looking at. 
 

Cancel button Click this to cancel the enrolment. All information entered will be lost.   

ERS User Guide for Gateway programmes  Page 16 of 36 



Learning plan 

The Learning Plan screen looks like this if nothing has been added to the indicative learning plan: 

 

 

It looks like this after adding unit standards: 

 

 

 
FIELD, BUTTON, LINK COMMENTS 

Assessment column Select “Work”, “School”, or “Shared” from the drop-down list to indicate where 
the assessment is most likely to occur. 

Remove button Click this to remove a unit standard from the list. 

Add Unit Standards button Click this to add a unit standard to the list.  The Find Unit Standards screen will 
appear. 

Back button Click this to return to the previous screen. (You will not lose what you have 
entered). 

Finish button Click this to move to the next screen. 

After adding unit standards, 
the screen looks like this. 

To remove a unit 
standard from the list 
click its Remove button. 

Click this button to add a 
unit standard to the list. 

The empty screen 
looks like this. 
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FIELD, BUTTON, LINK COMMENTS 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain 
missing information. The Parking screen will appear. 
 
NOTE: Parking an enrolment saves data from all four of the enrolment screens
not just the one you are looking at. 
 

Cancel button Click this to cancel the enrolment. All information entered will be lost.   
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Confirmation screen – number one 

The second to last screen for an enrolment is the confirmation screen number one. This screen 
provides a last chance to check everything you have entered and certify that it is correct. The 
screen appears after clicking the Next button in the Learning Plan screen and lists all the 
information entered on the four previous screens: 

 

 

 

 
FIELD, BUTTON, LINK COMMENTS 

Please declare the 
above to be true 

Select this field only if all the data entry is correct. 

Submit button Click this to submit the enrolment. 
 
Notes: 
 

 The screen will not appear to change however the top and the bottom of the page 
has. Refer to Confirmation Screen – number two 

 

Back button Click this to return to the previous screen.  (You will not lose what you have entered). 

Park button Click this if you need to “park” the enrolment while you clarify details or obtain missing 
information. The Parking screen will appear. 
 
NOTE: Parking an enrolment saves data from all four of the enrolment screens not just the 
one you are looking at. 

Cancel button Click this to cancel the enrolment. All information entered will be lost. 

3. Then click the Submit button. 

2. Complete the declaration by 
clicking (putting a tick in) this 
box if everything is correct.

1. Check all your data entry 
against the original 
enrolment form.

ERS User Guide for Gateway programmes  Page 19 of 36 



Confirmation screen – number two 

The last screen for an enrolment is the confirmation screen number two. The screen appears after 
clicking the Submit Button. The content of the enrolment details remains the same however the top 
and bottom of the page has changed. 

The top of the page instructs you to print the screen for audit purposes and allows you to close the 
enrolment screen or enrol another student on the same programme. 

At the bottom of the screen the Submit, Back, Park and Cancel buttons have been replaced by the 
options to close the enrolment screen or enrol another student on the same programme. 

 

3. Click this to return to the 
Programme Details Screen 

2.Click this to enrol another student 
on the same programme 

1. Print the screen. 
 
THIS IS IMPORTANT. See 

“Printout for audit purposes”

 

5. Click this to return to the 
Programme Details Screen 

4.Click this to enrol another student 
on the same programme 
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Printout for audit purposes 

Printing is a crucial step and mandatory for auditing purposes so ensure you keep the printout on 
your Gateway files. This is how you print the screen: 

 

Click the File menu 
and select Print. 

 

NOTE:  The File menu may look slightly different if you are not using Microsoft Internet Explorer. 

 
FIELD, BUTTON, LINK COMMENTS 

Enrol Another 
Student  

Click this return to the Student Details Screen enrolment. 
 

Close Click this to return to the Programme List 
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Screens:  Other actions 

This section describes the screens you will use to take other actions (such as amending student 
details). The screens are listed in alphabetical order. 

 

Add / Edit Employer screen 

This section describes two nearly identical screens, as follows: 
SCREEN NOTES 

Add Employer Use the Add Employer screen to enter a new employer’s details. The screen will appear 
after clicking the Add New Employer button in the Maintain Employers screen. 
 

Edit Employer Use the Edit Employer screen to modify an existing employer’s details. The screen will 
appear after clicking the Edit Employer button in the Maintain Employers screen. 
 

The Add Employer screen looks like this (the Edit Employer screen is nearly identical): 

 

 
FIELD, BUTTON, LINK COMMENTS 

Employer name The employer (company) name. 

Contact Contact person. 

Contact phone Phone number of the contact person. 

Address Line 1 
Address Line 2 
Suburb / Locale 
Town / City 

Address details. 

Industries this employer 
provides Gateway training in 

Select one or more industries. 

Save Employer button Click this to save employer details. 

Cancel button Click this to cancel your data entry. All information you have just entered into 
the screen will be lost. 

2. Click the Save Employer button. 

1. Enter or correct employer details. 
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Amend Student Details screen  

Use the Amend Student Details screen to modify a student’s previously-entered details (which 
were first entered when enrolling the student into this particular programme). Display the screen by 
clicking an Amend link in the Programme Details screen. 

 

 

1. Add information and amend 
the screen as appropriate. 

3. Click Save Amendment to 
save the changes. 

2. Select (tick) this field to certify that all 
information entered is correct when 
you are ready to save.  

NOTE: Once a student has been withdrawn from a programme it is only possible to the amend 
address and phone number. 
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FIELD, BUTTON, LINK COMMENTS 

PERSONAL DETAILS 

NSN 
Name 

Use this information to confirm you have selected the correct 
student. 

ADDRESS 

Street 
Suburb 
Town / City 
Contact phone number 
Other phone number 

Student address and contact details. 

GATEWAY PLACEMENT DETAILS 

This section of the screen works exactly the same way as the Placement Details screen (one of the 
enrolment screens). 
 

INDICATIVE LEARNING PLAN 

This section of the screen works exactly the same way as the Learning Plan screen (one of the enrolment 
screens). 
 

BOTTOM OF SCREEN 

Please declare the above to be true Select this field only if all the information is correct. 

Save Amendment button Click this to save the changes.   

Cancel button Click this to cancel the amendment. All information entered will be 
lost. 
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Delete Placement screen 

The Delete Placement screen is used to confirm a deletion. An enrolment may only be deleted if 
the student has been enrolled on the same day as you are deleting the enrolment or when the 
programme has not started. 

The screen appears after clicking a Delete Placement link in the Programme Details screen: 
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Find Unit Standards screen 

Use the Find Unit Standards screen to select unit standards to add to the indicative learning plan.  
Display the screen by clicking the Add Unit Standards button in one of the following screens: 

 Amend Student Details  

 Learning Plan (one of the enrolment screens) 

 

Use the Find Unit Standards screen like this: 

 

 
FIELD, BUTTON, LINK COMMENTS 

Unit standard id The unit standard id. 

Title keywords One or more words to search for in the title of the unit standard. 

Min credits 
Max credits 

Use these to limit the search to unit standards with a certain number of 
credits. 

Min level 
Max level 

Use these to limit the search to unit standards at a certain level. 

Field / Sub-field / Domain Select from the drop-down lists. 

Search button Click this to execute the search. 

Reset Search button Click this to clear all the search fields. 

Cancel button Click this to cancel the search. You will be returned to the screen you came 
from and nothing will be added to the indicative learning plan. 

Add Unit Standards button Click this to add the standards you selected to the indicative training plan.
You will be returned to the screen you came from. 

…the results are listed here. 

3. Select (tick) the unit standards 
you want to add to the indicative 
training plan. 

4. Click the Add Unit Standards 
button to return the screen you 
came from when ready. 
 
ERS will add the standards you 
selected to the indicative 
training plan. 

2. When you click the Search 
button… 

…enter search criteria in this 
area of the screen. 

1. Enter the unit standard id 
OR… 
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Maintain Employers screen 

Use the Maintain Employers screen to: 

 add a new employer to the list; or 

 edit an existing employer’s details; or 

 delete an existing employer. 

Display the screen by clicking the “To add, edit, delete…” link in one of the following screens: 

 Amend Student Details  

 Placement Details (one of the enrolment screens). 

 

Use the screen like this: 

 

OR click on one of the employers 
in the list THEN click this button 
to edit their details… 

OR click on one of the employers in 
the list THEN click this button to 
delete that employer. 

Click the Back button to return to the screen you came from 
when you have finished.

Click this button to add a new 
employer… 
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Parking screen 

Use the Parking screen to “park” an enrolment partway through data entry. You would do this if you 
need time to clarify data or obtain missing data before continuing. 

The screen appears after clicking the Park button on any of the enrolment screens: 

 

 

Notes: 

 Parking an enrolment saves information you have entered on all four of the enrolment 
screens not just the one you clicked the Park button in. 

 Remember to update the student start date when you “un-park” an enrolment. 

 
FIELD, BUTTON, LINK COMMENTS 

Comment Explain why you are parking the enrolment (eg. Waiting on confirmation from employer). 

Park this form 
button 

Click to confirm that you want to park the enrolment. The screen you originally came from 
will appear (Programmes List or Programme Details). 

Cancel button Click to cancel the “parking”. All information entered into this screen will be lost. 

2. Then click the “Park 
this form” button. 

1. Explain why you are 
parking the enrolment. 
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Record Outcome screen 

The Record Outcome screen is used to record each student’s labour market outcome. 

NOTE:  ERS will not allow you to do this until three months after withdrawal. 

 

The screen appears after clicking a Record Outcome link in the Programme Details screen. 

 

1.  Enter all relevant data into the screen. 
 
IMPORTANT:  Make sure you complete the correct tab.

 

NOTE: Which fields are visible depend on which tab you select (Employment / Further training / 
Other). 

 
FIELD, BUTTON, LINK COMMENTS 

TOP OF SCREEN 

NSN 
Name 
Student start date  
Student end date  

Use this information to confirm you have selected the correct student. 

EMPLOYMENT TAB 

Employment outcome Select the labour market outcome from the drop-down list. 

Contact person 
Contact phone number 
Fax number 
Email 

Contact person at the employer and their contact details. 

3. When you finished entering everything 
click the Save Outcome button. 

2. Click this button if there is more than one employer and 
then complete the additional fields that appear. 

ERS User Guide for Gateway programmes  Page 29 of 36 



FIELD, BUTTON, LINK COMMENTS 

Comments Any additional comments you would like to make about the outcome. 

Add Another Employer 
button 

Click this if there is more than one employer. More fields appear allowing you to 
enter the second employer. 
 

Remove button Only visible if more than one employer has been entered.  Click this button to 
remove the employer. 
 

FURTHER TRAINING TAB 

Training outcome Select from the drop-down list. 

Name of training 
organisation  

Name of the training organisation. 

Contact person 
Contact phone number 
Fax number 
Email 

Contact person at the training organisation and their contact details. 

Comments Any additional comments you would like to make about the outcome. 

OTHER TAB 

Other outcome Select from the drop-down list. 

Comments Any additional comments you would like to make about the outcome. 

BOTTOM OF SCREEN 

Save Outcome button Click this to save the outcome. 

Cancel button Click this to cancel the outcome. All information entered will be lost. 
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Withdrawal screen 
 

IMPORTANT: If you are using this screen to withdraw an enrolment made in error you must also 
send a “Enrolment in error” form to the TEC Service Centre. 

 

Use the Withdrawal screen if a student is withdrawing from a programme before the programme 
end date. The screen appears after clicking a Withdraw link in the Programme Details screen. 

 

1.  Enter all relevant data 
into the screen. 

 
FIELD, BUTTON, LINK COMMENTS 

NSN 
Name 
Student start date  

Use this information to confirm you have selected the correct student. 

Withdrawal date Date of withdrawal. 

Workplace learning placement 
proceeding as anticipated 

Select Yes or No. 

If No enter the reason. 

Save Withdrawal button Click this to save the withdrawal. 

Cancel button Click this to cancel the withdrawal. All information entered will be lost. 

2. Click the Save Withdrawal button when 
you have finished entering everything. 
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Screens:  Security  

This group of screens help protect ERS from unauthorised use. The screens are listed in 
alphabetical order.  

 

Choose Organisation screen 

This screen only appears if the user has authorisation to act on behalf of more than one 
organisation. For those users, the Choose Organisation screen appears after clicking the Login 
button in the Login screen: 

 

Click the Choose button next to the school you want to work as. The Programmes List screen 
appears. 

NOTE:  You can only be logged in to one school at a time. 

Change an organisation when already logged in 

To change school when you are already logged in: 

 Click the User Services menu 

 Select “Change your currently selected organisation” 
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Login screen 

Use the Login screen to log into ERS. Enter the following address in your web browser (Internet 
Explorer or similar) to display it: http://service.tec.govt.nz 

The login screen appears like this: 

 

 
FIELD, BUTTON, LINK COMMENTS 

Username Enter your username. (Obtaining username and password describes how to 
obtain a username and password.) 

Password Enter your password. 
 
Notes: 

 See Obtaining username and password if you do not have a username and 
password. 

 
 Use the Forgotten Password link (see below) if you have a username but 

have forgotten your password. 
 

Login button Enter your username and password and then click to log in. 
 
Notes: 

 For users set up to work on only one school, the Programmes List screen 
appears. But for users set up to work on multiple schools, the Choose 
Organisation screen appears. 

 
 You will be automatically logged off if you stop using ERS for 30 minutes. 

You will lose any information you have not parked. 
 

Clear button Click to remove all text from the Username and Password fields. 

Forgotten Password link Click if you have forgotten your password. The Forgotten Password screen 
appears. 
 

2. Then click the 
Login button. 

1. Enter your username 
and password. 
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Logout screen 

Log out of ERS like this: 

ACTION COMMENTS 

1. Click the Logout menu item 

 

2. Logout screen appears After clicking the Logout menu item the Logout screen appears: 

 

Click Logout. 

NOTE: If you click the “Back to ERS” 
link, the Login screen will reappear. 

 

IMPORTANT:  Always log out when you have finished to avoid unauthorised access to ERS. 
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Quick reference 

This summarises how to carry out various tasks in ERS: 

TOPIC ACTION HOW TO DO IT 

Challenge 
phrase 

Change Click User Services menu, then click “Change your challenge phrase”. 

Enrolment Amend student 
details 

Click Amend link next to the student (in the Programme Details screen). 

 Delete 
placement 

Click Delete Placement link next to the student (in the Programme 
Details screen). You may only delete an enrolment the same day or 
when the programme has not yet started. 
 
If parked, click Delete link next to the parked enrolment (in the 
Programmes List screen). 
 

 Enrol Click Enrol link next to the programme (in the Programmes List screen); 
OR 
Click Enrol link in the Programme Details screen. 

 Park Click Park button on any of the Enrolment screens: 

Personal Details 
Statistical Information 
Placement Details   
Learning Plan  
Confirmation  

 Record outcome Click Record Outcome link next to the student (in the Programme 
Details) screen. 
 

 Resume after 
parking 

Click Select link next to the parked enrolment (in the Programmes List 
screen). 
 

 Switch to 
different 
programme 

If you are in the Programme Details screen and want to start enrolling 
students in a different programme, click the Home menu and return to the 
Programmes List screen. 
 

 Withdraw Click Withdraw link next to the student (in the Programme Details screen)
If the enrolment was made in error, also send an “Enrolled In error” form 
to the TEC. 
   

Log in … See descriptions under Logging in and Login screen. 

Log out … Click Log out menu. 

Organisation Change See description under Change organisation when already logged in. 

Outcomes … See relevant entries under “Enrolment” in this quick-reference. 

Park … See relevant entries under “Enrolment” in this quick-reference. 

Password Change Click User Services menu, then click “Change your password”. 

Password Obtain See description under Obtaining username and password. 

Placement … See relevant entries under “Enrolment” in this quick-reference. 
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TOPIC ACTION HOW TO DO IT 

Programme List all Display Programmes List screen. 

 View details Display Programme Details screen. 

Security … See entries in this quick-reference under: 

Challenge phrase 
Log in 
Log out 
Organisation 
Password 
Username 

Student … See relevant entries under “Enrolment” in this quick-reference. 

Username Obtain See description under Obtaining username and password. 
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